
Section Header

Represents a header or label for a table, such as a parts list. To replace existing text, select the shape, 
then type.



Projection Symbol

Indicates the layout of views in a drawing. To change between first-angle projection and third-angle 
projection, right-click the shape. To add text, select the shape, then type.



File Properties Block

Use this shape to display information about the current file or drawing page. The shape automatically 
displays information you type in the Properties dialog box or settings stored with the page.
Each shape has a label and a field. The label can be above or to the left of the field. To reposition the 
label, right-click the shape. To edit the label, subselect the label, then type. To change the type of 
information in the field, select the shape, choose Insert > Field, and then choose a new category, field 
type, and format. To add field text or replace existing field text, select the shape, then type.



Pre-defined Title Block

To determine the paper size for which each shape is designed, pause the pointer over the master in the 
stencil and check the status bar. To add text to an individual block, right-click the shape, then choose 
Open For Editing to display the shape in the group window. In the group window, select an empty block or
part of a block, then type to add new text. Or, select existing text, then type. Click the group window close 
box to return to the drawing page.
Note: The SCALE and SHEET blocks contain fields that Visio updates automatically. If you type in these 
fields, Visio can no longer update them.



Frame

Use this shape to add a single-line border around a drawing. The shape resizes to fit the drawing page. 
To move the border, drag the control handles . To verify that the border is positioned on the printable 
portion of the drawing page, choose View > Page Breaks to display print margins.



Ruled Column Shape

Use this shape to add columns to text, such as parts lists or title blocks. To add text to a ruled column 
shape, select the shape, then type. To continue text on the next row, press the Enter key.

A      Drag to add or remove rows (1 to 5 or to 15, depending on shape). 
B      Drag to change column width.
C      Drag to change line height.



Zone Shape

Use this shape to add zoning labels around the edge of a drawing. The shape resizes to fit the drawing 
page. To verify that the zone rectangle is positioned on the printable portion of the drawing page, choose 
View > Page Breaks to display print margins.

A      Drag to position the lower-left and top-right corners of the zone rectangle.
B      Drag to change the width of the zone labels.



SI Symbol

Use this shape to add the Systeme Internationale d'Unites symbol that indicates use of metric units in the 
drawing. To change the symbol style, right-click the shape.



Revisions Block

To create a revisions table using this shape, duplicate the shape: Select the shape, then press the Ctrl 
key as you drag a copy of the shape away from the original. To replace existing text, select the shape, 
then type, separating fields with tab characters.

A      Drag to change the width of the field sections. The tab stops update automatically.
B      Drag to change the width or height.



Individual Block

Use this shape to build custom title blocks. Each shape has a label and a field. The label can be above or 
to the left of the field. To reposition the label, right-click the shape. To edit the field text, select the shape, 
then type. To edit the label, subselect the label, then type.



Parts List Block

To create a parts list table using this shape, duplicate the shape: Select the shape, then press the Ctrl key
as you drag a copy of the shape away from the original. To replace existing text, select the shape, then 
type, separating fields with tab characters.

A      Drag to change the width of the field sections. The tab stops update automatically.
B      Drag to change the width or height.



Scale Symbol

Use this shape to display drawing scale. The fields reflect the scale of the drawing page. To show or hide 
units, right-click the shape. To change the length or width, drag a side selection handle. When 
lengthened, this shape divides into proportional sections and the fields reflect the new dimensions.



Callout Shapes

Use to add a label to a shape in a drawing. To replace existing text, select the shape, then type. To adjust 
the break point in curved and bent callout lines, drag the control handle .



Break Line

Represents cut-off, long, or repetitive features.

A      Drag to change the height of the "knock-out" area.
B      Drag to resize the zigzag.



Drawing Scale

Use this shape to display the drawing scale. The fields reflect the scale of the drawing page. To change 
scale type, right-click the shape.



Elevation Note/Benchmark

To switch between elevation note and benchmark, right-click the shape. To move the text, drag the control
handle . To return Elevation Note text to its original position, right-click the shape. To replace existing 
text, select the shape, then type.



Property Line

As you drag a property line, the text reflects the new bearing and distance. To reposition the text, right-
click the shape. To precisely position a property line shape, choose Shape > Size & Position, then select 
the Begin, Length, and Angle values you want.
To draw a property outline using the Property Line add-on, right-click the property line shape, then choose
Create Property Outline. In the Property Lines dialog box, type the bearing and distance of each property 
line in one of the rows, then click Plot Lines.



North Arrow

To resize proportionally, drag any selection handle. To draw a property outline using the Property Line 
add-on, right-click a north arrow shape, then choose Create Property Outline. In the Property Lines dialog
box, type the bearing and distance of each property line in one of the rows, then click Plot Lines. The 
North Arrow will be linked to the property outline so when you rotate the outline the North Arrow also 
rotates.



North Arrow

Represents north in a drawing. To resize proportionally, drag any selection handle.



Reference

Use this shape to add references to notes, to other parts of a drawing, or to other drawings. To add text or
replace existing text, select the shape, then type. To position text below the centerline of divided reference
shapes, type the first line of text, then press Enter.
Reference callouts have control handles . To see what a control handle on a selected shape does, 
pause the pointer over the handle.



Drawing Scale

Use this shape to display the drawing scale. The fields reflect the scale of the drawing page. To change 
the length or width of the shape, drag a side selection handle.



Scale Symbol

Use this shape to display drawing scale. The fields reflect the scale of the drawing page. To show or hide 
units, right-click the shape. To change the length or width, drag a side selection handle. When 
lengthened, this shape divides into proportional sections and the fields reflect the new dimensions.



Ruled Column Shape

Use this shape to add columns to text, such as parts lists or title blocks. To add text, select the shape, 
then type. Press the Enter key to align text on the next row.

A      Drag to add or delete lines (1 to 5 or to 15, depending on shape). 
B      Drag to change the column width.
C      Drag to change row height.



Section Shape

Represents the cutting plane location for a sectional view. To hide or show the bottom arrows, right-click 
the shape, then choose the appropriate command.

A      Drag to change the length of the cutting lines. 
B      Drag to resize the arrows.
C      Drag to rotate the shape.



Text

Adds a text block to your drawing. To replace existing text, select the shape, then type. To create a 
border, select the shape, then choose a line style from the Line style list on the Shape toolbar.



Info. Line

Use to add a label and underline, such as for a signature. To replace existing text, select the shape, then 
type. To change the line length, drag a side selection handle.



Reference Plane

Use this shape to add reference notes about a plane or surface. To hide or show the reference labels, 
right-click the shape, then choose the appropriate command. To replace existing text, subselect one end 
of the shape, then type. To rotate the shape, drag an endpoint. To resize the labels, drag a side selection 
handle.



Benchmark

Place arrowhead next to the benchmark in a drawing. To rotate the shape, drag an endpoint.



Measurement Reference

Represents a significant reference line or plane from which measurements are taken. To replace existing 
text, select the shape, then type. To lengthen or shorten the extension line, drag a control handle . To 
show or hide the crossbar of the datum shape, right-click the shape, then choose the appropriate 
command.



Revision Cloud

Use to distinguish drawing details or to represent an unknown or external event or process. To reshape 
the cloud, use the pencil tool. To resize proportionally, drag a corner selection handle. To make wider, 
drag a side selection handle. To make taller, drag a top or bottom selection handle.



Callout

Use this shape to label areas of your drawing. To add text or replace existing text, select the shape, then 
type. To show or hide a box on some callouts, right-click the shape. Control handles provide other shape 
actions. To see what a control handle  on a selected shape does, pause the pointer over the handle.



Point-to-Point Connector

Use to connect two shapes between specific points with adjustable, bent lines. To connect shapes, glue 
an endpoint on this shape to a connection point  on the shapes. To change the arrowhead style, right-
click the shape, then choose Change Arrowhead. To add text, select the shape, then type. To move the 
text, right-click the shape, then choose the appropriate command.

A      Drag to glue point to point.
B      Drag to change where the connector bends.



Jumper

Use to connect shapes point to point with a line that jumps over drawing details. Position the jump over 
another line to indicate that the lines are not intended to touch. To connect other shapes, glue an endpoint
on this shape to a connection point  on the other shapes. To add text, select the shape, then type.

A      Drag to glue point to point.
B      Drag to move the jump along the line.
C      Drag to change the height of the jump.



Arrow Connector

Use this shape to connect two shapes between specific points with adjustable lines. To connect shapes, 
glue an endpoint on this shape to a connection point  on the other shapes. To add text, select the shape,
then type. To move the text, right-click the shape, then choose the appropriate command. To change 
arrowhead type, right-click the shape.

A      Drag to glue point to point.
B      Drag to change where the connector bends.



Straight or Curved Connector

Use to connect point to point or shape to shape with a straight or curved line. To add text, select the 
shape, then type. To change the arrowhead style, right-click the shape, then choose Change Arrowhead. 
To straighten a curved line, right-click the shape, then choose Set As Straight Line.

A      Drag to glue point to point, or Ctrl+drag to glue shape to shape.
B      Drag to change the curvature of the line.



Multi-line Connector

Use to connect two or more shapes between specific points with multiple lines. To connect shapes, glue 

an endpoint on this shape to a connection point  on the other shapes. To change the 
spacing between lines, drag the control handle 

. To add text, select the shape, then type.



Tree Connector

Represents a tree that has branches you can connect to other shapes. To connect other shapes, glue an 

endpoint on this shape to a connection point  on the other shapes. To add text, select
the shape, then type. You can add branches to the multi-tree shapes.

A      Drag to rotate the tree or change its length.
B      Drag to add more branches.
C      Drag to move the branch.



Wide Arrow Connector

Use this shape to connect two shapes between specific points with wide arrows. To connect shapes, glue 

an endpoint on this shape to a connection point  on the other shapes. To add text, 
select the shape, then type. To open or close the arrow's tail, right-click the shape, then choose the 
appropriate command. 

To change elbow bus arrow size, drag the control handle .



Universal Connector

Use to connect two 2-D shapes point to point or shape to shape with adjustable, bent lines. To connect 

other shapes, glue an endpoint on this shape to a connection point  on the other 
shapes. If you move 2-D shapes connected shape-to-shape, the ends of the connector move to connect 
the shapes' closest points. To change the arrowhead style, right-click the shape, then choose Change 
Arrowhead. To add text, select the shape, then type.

A      Drag to glue point to point, or Ctrl+drag to glue shape to shape.
B      Drag to change where the connector bends.



Angle Outside

Adds an angular dimension line with text and dimension outside the extension lines, which extend to the 
vertex of the angle. To hide or show extension lines, right-click the shape, then choose Extension Lines. 
To change the precision and units of the displayed dimension, right-click the shape. To set the shape's 
precision and unit settings as the default for all dimension shapes on the page, right-click the shape, then 
choose Set As Page Default.

A      Position at the vertex of the angle to be measured.
B      Drag to change the shape's angle to match the angle to be measured.
C      Drag to change the length of both dimension lines.
D      Drag to position dimension text.



Single Ordinate Shape

Adds a single ordinate (X or Y) dimension line. To bend the callout so that you can move the text, right-
click the shape, then choose Enable Movement. To change the precision and units of the displayed 
dimension, right-click the shape. To set the shape's precision and unit settings as the default for all 
dimension shapes on the page, right-click the shape, then choose Set As Page Default.

A      Drag to the edge of item to be measured.
B      Drag to change the line break location. (This handle is available only after you right-click the shape, 
then choose a command.)
C      Drag to change extension line length or move the dimension text.



Multiple Ordinate Shape

Adds up to four ordinate (X or Y) dimension lines. To hide an ordinate line, drag the control handles inside
of the shortest dimension line. To change the precision and units of the displayed dimension, right-click 
the shape. To set the shape's precision and unit settings as the default for all dimension shapes on the 
page, right-click the shape, then choose Set As Page Default.

A      Drag to left or bottom edge of initial area to be measured.
B      Drag to right or top edge of initial area to be measured.
C      Drag to right or top edge of additional areas to be measured.
D      Drag to change the extension line length or orientation.



Room Measurement

Displays the width and length of a rectangular area, such as a room. Drag a top or bottom handle to 
match the length (Y dimension) of the room. Drag a side handle to match the width (X dimension) of the 
room. To change the precision and units of the displayed dimension, right-click the shape. To set the 
shape's precision and unit settings as the default for all dimension shapes on the page, right-click the 
shape, then choose Set As Page Default.



Centerline

Adds crosshairs in your drawing. Drag control handles  to determine the upper-right 
and lower-left limits of the crosshair lines.



Baseline

Adds up to four baseline dimension lines. To change the precision and units of the displayed dimension, 
right-click the shape. To set the shape's precision and unit settings as the default for all dimension shapes
on the page, right-click the shape, then choose Set As Page Default. To hide a baseline, drag its 
corresponding control handle inside the shortest dimension line.

A      Drag to left or top edge of initial area to be measured.
B      Drag to right or bottom edge of initial area to be measured.
C      Drag to change the extension line height.
D      Drag to right or top edge of each additional area to be measured.
E      Drag to change spacing between dimension lines.



Special Characters

To add notes with special characters, place the insertion point in this shape, then type. To replace existing
text, select the shape, then type. To type special characters, press Alt + the extended character code on 
the keypad. Point to the master on the stencil, then refer to the status bar for the character codes.



Horizontal or Vertical

Adds a single dimension line with the measurement between the extension lines. To change the precision 
and units of the displayed dimension, right-click the shape. To set the shape's precision and unit settings 
as the default for all dimension shapes on the page, right-click the shape, then choose Set As Page 
Default. To hide or show one or both extension lines, right-click the shape, then choose Extension Lines.

A      Drag to left or top edge of item to be measured.
B      Drag to right or bottom edge of item to be measured.
C      Drag to position dimension text.
D      Drag to change extension line height.



Horizontal or Vertical Outside

Adds a dimension line with extension lines that can be different lengths. The dimension appears outside 
the extension lines. To hide or show one or both extension lines, right-click the shape, then choose 
Extension Lines. To change the precision and units of the displayed dimension, right-click the shape. To 
set the shape's precision and unit settings as the default for all dimension shapes on the page, right-click 
the shape, then choose Set As Page Default.

A      Drag to left or top edge of item to be measured.
B      Drag to right or bottom edge of item to be measured.
C      Drag to position dimension text.
D      Drag to change extension line height.



Aligned Even

Adds a dimension line with equal length extension lines for measuring an angled edge. To hide or show 
extension lines, right-click the shape, then choose Extension Lines. To change the precision and units of 
the displayed dimension, right-click the shape. To set the shape's precision and unit settings as the 
default for all dimension shapes on the page, right-click the shape, then choose Set As Page Default.

A      Drag to right edge of item to be measured.
B      Drag to left edge of item to be measured.
C      Drag to position dimension text.
D      Drag to change extension line height.



Radius and Diameter Dimension

To change the precision and units of the displayed dimension, right-click the shape. To set the shape's 
precision and unit settings as the default for all dimension shapes on the page, right-click the shape, then 
choose Set As Page Default. To hide or show crosshairs, right-click the shape, then choose the 
appropriate command. To resize the leader or crosshair line, change the value in the ShapeSheet 
Scratch.X1 or Scratch.Y1 cells. (The value is the physical size of the line, not scaled drawing units.)

A      Drag to the center of the arc or circle.
B      Drag to a point on the arc or circle. 
C      Drag to position dimension text.



Angle Center

Adds an angular dimension line with extension lines of equal lengths that extend to the vertex of the 
angle. To hide or show extension lines, right-click the shape, then choose Extension Lines. To change the 
precision and units of the displayed dimension, right-click the shape. To set the shape's precision and unit
settings as the default for all dimension shapes on the page, right-click the shape, then choose Set As 
Page Default.

A      Position at the vertex of the angle to be measured.
B      Drag to change the shape's angle to match the angle to be measured.
C      Drag to change the overall size of the shape.
D      Drag to position dimension text.
E      Drag to rotate the shape.



Angle Uneven

Adds an angular dimension line with extension lines of different lengths that extend to each of the handles
that specify the angle. To hide or show extension lines, right-click the shape, then choose Extension 
Lines. To change the precision and units of the displayed dimension, right-click the shape. To set the 
shape's precision and unit settings as the default for all dimension shapes on the page, right-click the 
shape, then choose Set As Page Default.

A      Position at the vertex of the angle to be measured.
B      Drag to change the shape's angle to match the angle to be measured or to change the top extension 
line length.
C      Drag to resize the shape.
D      Drag to position dimension text.
E      Drag to rotate the shape or to change the bottom extension line length.



Aligned Uneven

Adds a dimension line with different length extension lines for measuring an angled edge. To hide or show
extension lines or to change the precision and units of the displayed dimension, right-click the shape. To 
set the shape's precision and unit settings as the default for all dimension shapes on the page, right-click 
the shape, then choose Set As Page Default.

A      Drag to right edge of item to be measured.
B      Drag to left edge of item to be measured.
C      Drag to change the shape's angle and make it parallel to the measured item.
D      Drag to position dimension text.
E      Drag to change extension line height.



Angle Even

Adds an angular dimension line with extension lines of equal length that you can specify. To hide or show 
extension lines or to change the precision and units of the displayed dimension, right-click the shape. To 
set the shape's precision and unit settings as the default for all dimension shapes on the page, right-click 
the shape, then choose Set As Page Default.

A      Position at the vertex of the angle to be measured.
B      Drag to change the shape's angle to match the angle to be measured.
C      Drag to resize the shape.
D      Drag to position dimension text.
E      Drag to rotate the shape.
F      Drag to change the extension line length.



Aligned Out Even

Adds a dimension line with equal length extension lines for measuring an angled edge. The dimension 
appears outside the extension lines. To hide or show extension lines, right-click the shape, then choose 
Extension Lines. To change the precision and units of the displayed dimension, right-click the shape. To 
set the shape's precision and unit settings as the default for all dimension shapes on the page, right-click 
the shape, then choose Set As Page Default.

A      Drag to right edge of item to be measured.
B      Drag to left edge of item to be measured.
C      Drag to position dimension text.
D      Drag to change extension line height.



Aligned Out Uneven

Adds a dimension line with different length extension lines for measuring an angled edge. The dimension 
appears outside the extension lines. To hide or show extension lines or to change the precision and units 
of the displayed dimension, right-click the shape. To set the shape's precision and unit settings as the 
default for all dimension shapes on the page, right-click the shape, then choose Set As Page Default.

A      Drag to right edge of item to be measured.
B      Drag to left edge of item to be measured.
C      Drag to change the shape's angle and make it parallel to the measured item.
D      Drag to position dimension text.
E      Drag to change extension line height.






